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Introduction
Date Effective Tax Rates allows you to set up different tax percentages for a tax 
detail ID for various date ranges as specified by the tax authority. The tax 
percentage that you set up for a date range overrides the tax percentages set up in 
Microsoft Dynamics GP for transactions that fall within the specified date range. 
You also can update tax detail IDs in the Tax Detail Maintenance window with the 
tax percentage using Date Effective Tax Rates. Date Effective Tax is applicable on 
saved transactions originating from the Receivables Management, Sales Order 
Processing, Payables Management and Purchase Order Processing modules in 
Microsoft Dynamics GP.

Check for current instructions
This information was current as of December 2010. The documentation may be 
updated as new information becomes available. Check the Microsoft Dynamics GP 
online Web site (http://go.microsoft.com/fwlink/?LinkID=161199) for the most 
current documentation.

The introduction is divided into the following sections:

• What’s in this manual
• Symbols and conventions
• Resources available from the Help menu
• Send us your documentation comments

What’s in this manual

This manual is designed to give you an in-depth understanding of how to use the 
features of Date-effective tax, and how it integrates with the Microsoft Dynamics GP 
system.

To make best use of Date-effective tax, you should be familiar with systemwide 
features described in the System User’s Guide, the System Setup Guide, and the 
System Administrator’s Guide.

Some features described in the documentation are optional and can be purchased 
through your Microsoft Dynamics GP partner.

To view information about the release of Microsoft Dynamics GP that you’re using 
and which modules or features you are registered to use, choose Help >> About 
Microsoft Dynamics GP.

This manual is divided into the following chapters:

• Chapter 1, “Setup,” describes how to set up tax percentages for different date 
ranges for a tax detail ID.

• Chapter 2, “Routines,” describes how to generate taxes with the tax 
percentages.

http://go.microsoft.com/fwlink/?LinkID=161199
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Symbols and conventions

For definitions of unfamiliar terms, see the glossary in the manual or refer to the 
glossary in Help.

This manual uses the following conventions to refer to sections, navigation and 
other information.

Resources available from the Help menu

The Microsoft Dynamics GP Help menu gives you access to user assistance 
resources on your computer, as well as on the Web.

Contents
Opens the Help file for the active Microsoft Dynamics GP component, and displays 
the main “contents” topic. To browse a more detailed table of contents, click the 
Contents tab above the Help navigation pane. Items in the contents topic and tab 
are arranged by module. If the contents for the active component includes an 
“Additional Help files” topic, click the links to view separate Help files that 
describe additional components.

To find information in Help by using the index or full-text search, click the 
appropriate tab above the navigation pane, and type the keyword to find.

To save the link to a topic in the Help, select a topic and then select the Favorites tab. 
Click Add.

Index
Opens the Help file for the active Microsoft Dynamics GP component, with the 
Index tab active. To find information about a window that’s not currently displayed, 
type the name of the window, and click Display.

About this window
Displays overview information about the current window. To view related topics 
and descriptions of the fields, buttons, and menus for the window, choose the 
appropriate link in the topic. You also can press F1 to display Help about the current 
window.

Symbol Description

The light bulb symbol indicates helpful tips, shortcuts and 
suggestions.

The warning symbol indicates situations you should be 
especially aware of when completing tasks.

Convention Description

Creating a batch Italicized type indicates the name of a section or procedure.

File >> Print or File > 
Print

The (>>) or (>) symbol indicates a sequence of actions, such as 
selecting items from a menu or toolbar, or pressing buttons in 
a window. This example directs you to go to the File menu and 
choose Print.

TAB or ENTER All capital letters indicate a key or a key sequence.
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Lookup
Opens a lookup window, if a window that you are viewing has a lookup window. 
For example, if the Checkbook Maintenance window is open, you can choose this 
item to open the Checkbooks lookup window.

Show Required Fields
Highlights fields that are required to have entries. Required fields must contain 
information before you can save the record and close the window. You can change 
the font color and style used to highlight required fields. On the Microsoft 
Dynamics GP menu, choose User Preferences, and then choose Display.

Printable Manuals
Displays a list of manuals in Adobe Acrobat .pdf format, which you can print or 
view.

What’s New
Provides information about enhancements that were added to Microsoft Dynamics 
GP since the last major release.

Microsoft Dynamics GP Online
Opens a Web page that provides links to a variety of Web-based user assistance 
resources. Access to some items requires registration for a paid support plan.

Current implementation and upgrade information The most recent 
revisions of upgrade and implementation documentation, plus documentation 
for service packs and payroll tax updates.

User documentation and resources The most recent user guides, how-
to articles, and white papers for users.

Developer documentation and resources The most recent 
documentation and updated information for developers.

Product support information Information about the Microsoft Dynamics 
GP product support plans and options that are available, along with 
information about peer support and self-support resources.

Services information Information about Microsoft Dynamics GP support, 
training, and consulting services.

Microsoft Dynamics GP Community Access to newsgroups, where you 
can ask questions or share your expertise with other Microsoft Dynamics GP 
users.

CustomerSource home page A wide range of resources available to 
customers who are registered for a paid support plan. Includes access to 
Knowledge Base articles, software downloads, self-support, and much more.

Customer Feedback Options
Provides information about how you can join the Customer Experience 
Improvement Program to improve the quality, reliability, and performance of 
Microsoft® software and services.
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Send us your documentation comments

We welcome comments regarding the usefulness of the Microsoft Dynamics GP 
documentation. If you have specific suggestions or find any errors in this manual, 
send your comments by e-mail to the following address: bizdoc@microsoft.com.

To send comments about specific topics from within Help, click the Documentation 
Feedback link, which is located at the bottom of each Help topic.

Note: By offering any suggestions to Microsoft, you give Microsoft full permission to use 
them freely.

mailto:bizdoc@microsoft.com
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Chapter 1: Setup
Use this information to activate Date Effective Tax Rates and set up different tax 
percentages for a tax detail ID for various date ranges as specified by the tax 
authority.

This information is divided into the following sections:

• Activating Date Effective Tax Rates
• Setting up tax percentages for a tax detail ID

Activating Date Effective Tax Rates

You must activate Date Effective Tax Rates to enable you to set up different tax 
percentages for various date ranges for a tax detail ID.

To activate Date Effective Tax Rates:
1. Open the Date Effective Tax Setup window.

(Microsoft Dynamics GP menu >> Tools >> Setup >> Company >> 
Company >> Options >> Additional >> Date Effective Tax Rates Setup)

The Company ID field displays the company ID that you have logged into.

2. Mark the Use Date-effective Tax checkbox to activate Date Effective Tax Rates.

3. Select an option in the Date to Use field based on which taxes are recalculated.

Posting Date Select this option to consider posting date of the transactions 
to recalculate taxes.

Tax Date Select this option to consider tax date of the transactions to 
recalculate taxes.

This option is available only if you have marked the Enable tax date option in the 
Company Setup Options window.(Microsoft Dynamics GP menu >> Tools > Setup >> 
Company >> Company >> Options button). Refer to Microsoft Dynamics GP 
documentation for more information.

Document Date Select this option to consider document date of the 
transactions to recalculate taxes.

4. Choose OK to save the settings and close the window.

Setting up tax percentages for a tax detail ID

Use the Date Effective Tax Rates window to set up different tax percentages for a tax 
detail ID for various date ranges as specified by the tax authority. This window is 
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available only if you have activated Date Effective Tax Rates in the Date Effective 
Tax Setup window. Refer to Activating Date Effective Tax Rates on page 5 for more 
information.

To set up tax percentages for a tax detail ID:
1. Open the Date Effective Tax Rates window.

(Microsoft Dynamics GP menu >> Tools >> Setup >> Company >> Tax 
details >> Additional >> Date Effective Tax)

The tax detail ID, description of the tax detail ID, and the option based on which 
the tax is calculated is displayed from the Tax Detail Maintenance window.

2. Enter the date range in the From Date and To Date fields respectively for which 
to set up the tax percentage.

You can set up multiple date ranges and tax rates for a tax detail ID.

3. Enter the tax percentage or the tax amount depending on the option selected in 
the Based On field of the tax detail ID. Refer to Microsoft Dynamics GP 
documentation for more information.

4. Choose OK to save the settings and close the window.
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Chapter 2: Routines
You can update the tax detail IDs with tax percentages and regenerate taxes for 
transactions that fall within the specified date range. You also can update the tax 
detail IDs with the tax percentage in Tax Detail Maintenance window (Microsoft 
Dynamics GP menu >> Tools >> Setup >> Company >> Tax Details).

This information is divided into the following sections:

• Updating tax percentages for tax detail IDs
• Regenerating taxes

Updating tax percentages for tax detail IDs

Use the Mass Modify Taxes window to update different tax percentages for multiple 
tax detail IDs for various date ranges at a time. You also can use this window to 
update the tax percentages for tax detail IDs in the Tax Detail Maintenance window 
(Microsoft Dynamics GP menu >> Tools >> Setup >> Company >> Tax Details).

To update tax percentages for tax detail IDs:
1. Open the Mass Modify Taxes window.

(Microsoft Dynamics GP menu >> Tools >> Routines >> Company >> Mass 
Modify Tax Percentages)

2. In the Modify field, select whether to set up the tax percentage only for a date 
range, update the tax percentage for the tax detail ID in Tax Detail Maintenance 
window or both.

Date Effective Tax Select this option to set up tax percentages for tax detail 
IDs that are effective for a particular date range. This tax percentage is updated 
in the Date Effective Tax Rates window. Refer to Setting up tax percentages for a 
tax detail ID on page 5 for more information.
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Tax Details Select this option to update tax percentages for the selected tax 
detail IDs in the Tax Detail Maintenance window (Microsoft Dynamics GP 
menu >> Tools >> Setup >> Company >> Tax Details).

The selected tax detail IDs are updated with the tax rates of the most recent date 
range that you have specified for the tax detail ID in the Date Effective Tax 
Rates window. Refer to Setting up tax percentages for a tax detail ID on page 5 
for more information. Refer to Setting up tax percentages for a tax detail ID on 
page 5 for more information.

Both Select this option to update tax percentages for the selected tax detail 
IDs in the Date Effective Tax Rates window and also in the Tax Detail 
Maintenance window (Microsoft Dynamics GP menu >> Tools >> Setup >> 
Company >> Tax Details).

If you modify tax percentages by selecting Tax Details or Both as the option, you can 
view the updated tax percentages for the selected tax detail IDs in the Tax Detail 
Maintenance window (Microsoft Dynamics GP menu >> Tools >> Company >> Tax 
Details). Refer to Microsoft Dynamics GP documentation for more information.

3. Select the criteria based on which to specify the range, whether tax detail ID or 
tax detail type, and specify the range for the selected criteria in the From and To 
fields respectively.

4. Select the date range for which you are setting up the tax percentage in the Date 
From and Date To fields respectively. These fields are available only if you have 
selected Date Effective Tax or Both as the option in the Modify field.

5. Enter the tax percentage or the tax amount for the corresponding date range. 
This field is available only if you have selected Date Effective Tax or Both as the 
option in the Modify field.

Whether the value corresponds to percentage or flat amount depends upon the tax 
calculation base of the tax detail ID that is set up in the Tax Detail Maintenance 
window.

6. Choose Insert to insert the information for the selected criteria in the scrolling 
window.

The scrolling window displays tax detail IDs for the selected range, tax 
calculation base for each tax detail ID, and the date range and tax percentage/
amount that you have specified.

7. You can modify the date range and tax percentages/amount in the scrolling 
window for each tax detail ID, if required.

8. Choose Remove to remove the highlighted tax detail ID from the scrolling 
window.

9. Choose Modify to update the tax percentages depending on the option selected 
in the Modify field.

10. Choose Clear to clear the information displayed in the window.
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Regenerating taxes

Use this information to regenerate taxes with the tax percentage or tax amount 
specified in the Date Effective Tax Rates window for all saved transactions that fall 
within the specified date range. Refer to Setting up tax percentages for a tax detail ID 
on page 5.

To regenerate taxes:
1. Open the Regenerate Taxes window.

(Microsoft Dynamics GP menu >> Tools >> Routines >> Company >> 
Regenerate Taxes)

2. Select the module for which to regenerate taxes.

Taxes are not regenerated for purchase orders in the Purchase Order Processing module.

3. Select the range of batches for which to regenerate taxes.

4. Choose Insert to insert the selected range of batches in the restrictions list.

5. Choose Remove to remove range of batches from the restrictions list.

6. Choose Process to regenerate taxes with the tax percentage or amounts for 
transactions that are saved in the selected batches.

Ensure that you have backed up your database before regenerating taxes.

7. Choose Cancel to cancel the process and close the window.
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Chapter 3: Reports
This chapter illustrates the reports that are generated when you update tax detail 
IDs with the changed tax rates, and reports generated when you regenerate taxes 
for saved transactions with these new tax rates. Refer to Updating tax percentages for 
tax detail IDs on page 7 and Regenerating taxes on page 9 for more information.

This information is divided into the following sections:

• Mass Modify Taxes report
• Mass Modify Exception report
• Mass Modify Tax Rates report
• Tax Correction report
• Tax Correction Exception report

Mass Modify Taxes report

Mass Modify Taxes report prints the changed tax rates and the date range for which 
the tax rates that you have updated in the Date Effective Tax Rates window.

Mass Modify Exception report

Mass Modify Exception report will print the list of all tax detail IDs for which the 
changed tax rates are not updated.
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Mass Modify Tax Rates report

Mass Modify Tax Rates report will print the information of tax detail IDs that are 
updated with the change percentage in the Tax Detail Maintenance window. Refer 
to Updating tax percentages for tax detail IDs on page 7 for more information.

Tax Correction report

Tax Correction report prints all transactions for which tax amounts were 
recalculated after you regenerate the taxes.
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Tax Correction Exception report

Tax Correction Exception report prints all transactions for which tax amounts were 
not recalculated after you regenerate the taxes.
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Glossary
Date effective tax rates

The tax percentage for a tax detail ID that is 
effective for a particular date range.
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